
ЛАБОРАТОРНА РОБОТА №1. 

Моделювання технологічних операцій виготовлення напівпровідникового діода. 

  

1.1. ТЕОРЕТИЧНА ЧАСТИНА 

  

В теоретичній частині лабораторної роботи будуть розглянуті наступні питання: 

1.      Історія розвитку технологічних операцій в мікроелектроніці; 

2.      Виготовлення кристалічного кремнію; 

3.      Індукційна плавка напівпровідників та металів; 

4.      Розрізання злитку монокристалічного кремнію на пластини; 

5.      Шліфування та полірування напівпровідникових пластин; 

6.      Очищення напівпровідникових пластин; 

7.      Вирощування шарів оксиду кремнію та полікристалічного кремнію; 

8.      Епітаксія; 

9.      Плазмове та хімічне травлення; 

10.  Фотолітографія; 

11.  Введення домішок в напівпровідник за допомогою дифузії та іонної імплантації; 

12.  Нанесення тонких плівок матеріалів на напівпровідникові пластини; 

13.  Методи ізоляції напівпровідникових приладів (діодів, транзисторів) на підкладці; 

14.  Основні етапи технології виготовлення діодів. 

Розглянемо зазначені етапи більш детально. 

  

1.1.1   Історія розвитку технологічних операцій в мікроелектроніці. 

  

В статтях [1,2] розглянуто розвиток мікроелектроніки та сучасні технології 

виготовлення мікросхем на зразок напруженого кремнію, самосуміщеного затвору, мідних 

міжз’єднань та 3D транзисторів. Матеріал статті [1] не є обов’язковим для захисту 

лабораторної роботи, але для загального розвитку його рекомендується прочитати. Ця 

стаття досить велика і для опрацювання потребує кількох годин, тому можливо варто її 

відкласти на кінець. Стаття [2] проста і відносно невелика, тому необхідно одразу її 

прочитати та в першу чергу звернути увагу на 3 проблеми виготовлення мікросхем 

(інтеграцію, ізоляцію та виготовлення міжз’єднань) і на те, як винахідники запропонували 

їх вирішувати. Історичну інформацію у другій половині статті [2] можна опустити. 

1.1.2.      Виготовлення кристалічного кремнію 
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Існує 4 типи кремнію: технічний (дуже велика кількість домішок інших матеріалів), 

полікристалічний, монокристалічний кремній сонячної якості (для сонячних батарей), 

монокристалічний кремній електронної якості (найбільш чистий кремній для 

виготовлення мікросхем. Кількість домішок не більше 0.0000001%). Про відмінності між 

зазначеними типами кремнію написано в [3]. 

Спочатку одержують технічний кремній, потім очищуючи його отримують 

полікристалічний кремній сонячної, або електронної якості. З полікристалічного кремнію 

вирощують кристали монокристалічного кремнію. Про виготовлення технічного та 

полікристалічного кремнію можна почитати у книзі [4, розд.1.2., стр.19-23]. За методом 

Чохральського вирощують злитки монокристалічного кремнію діаметром 300 та 450 мм та 

довжиною кілька метрів. 

Вирощування кристалів монокристалічного кремнію за методом Чохральського 

описано в [5], [10, розділ 6.2., стр.169] та наочно продемонстровано на 3D моделях у відео 

[6-7, 14]. 

  

1.1.3.      Індукційна плавка напівпровідників та металів 

  

Створення розплаву кремнію у методі Чохральського відбувається за допомогою 

індукційної плавки, коли резервуар (тигель) з подрібненим полікристалічним кремнієм 

поміщають у потужне змінне електромагнітне поле, створене котушкою-індуктором. 

Змінне електромагнітне поле наводить у кремнії вихрові струми, які розігрівають його, що 

приводить до розплавлення матеріалу. Подібним чином одержують розплави металів. 

Приклад індукційної плавки алюмінію наведений у відео [8] та більш детально описаний в 

[13]. 

  

1.1.4.   Розрізання злитку монокристалічного кремнію на пластини; 

  

Злиток монокристалічного кремнію високої чистоти, одержаний шляхом 

вирощування за методом Чохральського, механічним способом доводять до однакового 

діаметру по всій довжині та розрізають на тонкі кремнієві пластини (підкладки), діаметр 

яких дорівнює діаметру злитку (300, або 450 мм), а товщина складає 0.775 мм для 300 мм 

пластин та 0.925 мм для 450 мм пластин. Процес розрізання кристалу на пластини 

відбувається за допомогою надтонких (діаметр 100-200 мкм) металічних тросів з 

абразивним покриттям (мікроскопічними діамантовими крихтами), що продемонстровано 

у відео [7]. 
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Процес виготовлення напівпровідникових пластин (підкладок) також гарно 

описаний у [9]. 

 

1.15.   Шліфування та полірування напівпровідникових пластин 

  

Після розрізання поверхня пластини покрита мікронерівностями, які згладжуються 

шляхом шліфування та полірування. Процес описаний в [10, стр.170] та показаний на 

відео [6-7, 14]. Більш детальний опис можна знайти в [11, стр.46-50]. 

  

1.1.6.   Очищення напівпровідникових пластин 

  

Під час проведення технологічних операцій по виготовленню мікросхем 

(нанесення фоторезисту, вирощування шару оксиду, нанесення плівок металів, введення 

домішок і т.д.) поверхня кремнієвої пластини має бути ідеально чистою та вільною від 

всіх можливих типів забруднень, оскільки попадання забруднень в структуру мікросхеми 

значно погіршує її конструктивні та електричні характеристики. Перед кожною 

технологічною операцією поверхню кремнієвої пластини очищають, а самі операції 

проводять у надчистих приміщеннях вільних від пилу і бруду. Типи забруднень 

напівпровідникових пластин та способи усунення таких забруднень описані в [11, 

розд.4.2., стр.55] та у розділі 1 джерела [12]. 

 

1.1.7.   Вирощування шарів оксиду кремнію та полікристалічного кремнію 

  

Шар оксиду кремнію на поверхні кремнієвої пластини відіграє захисну та 

ізолюючу функції під час виконання технологічних операцій виготовлення мікросхем, а 

також функцію тонкого діелектрику під затвором МДН транзисторів. Шар провідного 

полікристалічного кремнію виконує функцію затвору в польових МДН транзисторах та 

роль провідників першого шару міжз’єднань. За допомогою провідників з полікремнію 

можуть сполучатися сусідні транзистори логічних вентилів. 

Вирощування шару оксиду кремнію описано в [10, розд. 6.4., стр.173-175] та на 

відео [14]. Більш детальну інформацію по вирощуванню шару оксиду кремнію з 

реальними прикладами можна одержати з [12, розд.1,8,10]. 

Вирощування шару полікристалічного кремнію описано в [12, розд.12]. 

  

1.1.8.   Епітаксія 
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За допомогою процесу епітаксії на напівпровідниковій підкладці можна виростити 

шар монокристалічного кремнію, який повторює орієнтацію кристалічної гратки. При 

цьому, вирощений епітаксіальний шар може мати інший тип провідності ніж підкладка, 

що досягається за рахунок введення домішок донорів чи акцепторів під час епітаксії. 

Концентрація домішок у створеному епітаксіальному шарі буде однакова в будь якій його 

області (на відміну від введення домішок шляхом дифузії, чи іонної імплантації). 

Процес епітаксії описано в [10, розд.6.3., стр.171-173]. 

  

1.1.9.      Плазмове та хімічне травлення 

  

Технологічний процес травлення використовується для видалення з поверхні 

підкладки областей раніше нанесеного оксиду кремнію, фоторезисту, металу, або іншого 

матеріалу. Травлення оксиду кремнію, металу та інших матеріалів відбувається через 

маску (трафарет) з фоторезисту, внаслідок чого видаляються лише участки не захищені 

фоторезистом. Травлення в рідких травниках (кислотах) має той недолік, що кислоти 

виконують травленння (видаляють матеріал) в усіх напрямках, що приводить до 

підтравлювання під маску з фоторезисту, внаслідок чого геометрія витравлених в оксиді 

кремнію вікон не співпадає з запланованою. Для видалення матеріалу лише у 

вертикальному напрямку використовують анізотропне травлення у плазмі. 

Процес рідкого та плазмового травлення описаний в [10, розд.6.6., стр.184-186] та 

на відео [14]. Більш детально рідке травлення розглянуто в [11, розд.4.4., стр.59-60]. 

Анізотропне травлення у плазмі детально розглянуто в [11, розд.4.8-4.9]. 

 

1.1.10.  Фотолітографія 

  

Фотолітографія є одним з основних етапів виготовлення мікросхем, оскільки з її 

допомогою створюють вікна в оксиді кремнію через які вводять домішки в кремнієву 

пластину, або зтравлюють залишки раніш нанесеного металу, формуючи з’єднувальні 

провідники. Загалом фотолітографія дозволяє створити вікно у фоторезисті, через яке до 

кремнієвої пластини, не закритої фоторезистом, можна застосувати будь-яку технологічну 

операцію (введення домішок, нанесення тонких плівок, епітаксія, тощо). 

Фотолітографія складається з наступних етапів: 

-         нанесення фоторезисту на кремнієву пластину; 

-  засвічування фоторезисту (експонування) за допомогою лазера або джерела 

ультрафіолетового світла через маску (фотошаблон); 

-  видалення засвічених (для позитивного фоторезисту), або незасвічених (для 

негативного фоторезисту) областей фоторезисту шляхом його проявлення та 

промивки; 

-         травлення матеріалу через вікна у фоторезисті; 

-         видалення фоторезисту. 
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Типи фоторезистів описані в [15]. Процес виготовлення масок (фотошаблонів) 

описаний в [16]. Ціни виготовлення фотошаблонів та обладнання для проведення 

фотолітографії наведені в [17]. Загалом процес фотолітографії описаний в [10, розд.6.7., 

стр.187-192], [18] та наочно продемонстрований на відео [14]. Приклади фотолітографії 

наведені в [12, розд. 4, 11, 15]. 

 Засвічування фоторезисту за допомогою степерів та сканерів описане в [14, 17, 21]. 

 

1.1.11.  Введення домішок в напівпровідник за допомогою дифузії та іонної 

імплантації 

  

Введення домішок в області кремнієвої пластини через отвори в оксиді кремнію, 

створені за допомогою фотолітографії, виконують за допомогою технологічних операцій 

дифузії та іонної імплантації. Дифузія домішок розглянута в [10, розд.6.5., стр.176-182], а 

іонна імплантація – в [10, розд.6.5., стр.182-183], в [19] та на відео [14]. Більш детально 

процес дифузії домішок розглянуто в [11, розд.9.2.-9.3.]. 

Приклад іонної імплантації наведений в [12, розд.5]. Приклад дифузії наводиться в 

[12, розд.16]. 

Цікавим прикладом введення домішок є використання так званого spin-on glass. 

Саме подібний підхід буде застосовано в даній лабораторній роботі. Перевагою spin-on 

glass є простота технологічного процесу та нижча вартість обладнання/реактивів у 

порівнянні з дифузійними печами. Spin-on glass являє собою розчин оксиду кремнію з 

високою концентрацією домішок певних речовин (миш’як, бор, фосфор, тощо). На 

поверхню кремнієвої пластини spin-on glass наносять за допомогою центрифуги (майже 

так само, як фоторезист). Кремнієву пластину розкручують до високих обертів (3000-5000 

об/хв), дозатором подають кілька крапель spin-on glass. Під дією відцентрової сили spin-on 

glass рівномірно розподіляється по поверхні пластини. Подібним чином можна нанести 

шар spin-on glass товщиною порядку 2000 Ангстрем. Далі пластину висушують, а потім 

нагрівають до високої температури, внаслідок чого відбувається дифузія домішок зі spin-

on glass в кремнієву пластину. Залишки spin-on glass видаляють з використанням 

плавікової кислоти HF. Перелік наявних у продажу spin-on glass наведений у [22], а 

технологія нанесення описана в [23]. 

  

1.1.12.  Нанесення тонких плівок матеріалів на напівпровідникові пластини 

  

Тонкі плівки металів наносять на поверхню напівпровідника найчастіше для 

створення металічних міжз’єднань. Технологія вакуумного напилення розглянута в [10, 

розд.6.8., стр.193-198].  Створення металічних міжз’єднань описано в [10, розд.6.9.] та на 

відео [14]. 

Зверніть увагу на особливості формування алюмінієвих контактів до областей 

кремнієвої пластини з провідністю n-типу [10, стр.202]. 
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1.1.13.  Методи ізоляції напівпровідникових приладів (діодів, транзисторів) на 

підкладці 

  

Виготовлені на кремнієвій підкладці компоненти інтегральних мікросхем (діоди, 

транзистори) необхідно електрично ізолювати один від одного. Методи ізоляції 

компонентів на підкладці, зокрема ізоляцію зворотно зміщеним p-n переходом, розглянуто 

в [10, розд.7.2.]. 

  

1.1.14.  Основні етапи технології виготовлення напівпровідникових діодів 

  

Приклад планарної дифузійної технології виготовлення діодів: 

 

 

 

 

1.2. ПРАКТИЧНА ЧАСТИНА 

Моделювання технологічного процесу виготовлення напівпровідникового діода 

в Sentaurus TCAD 

 

1.2.1. Загальні відомості про програму Sentaurus TCAD 

  

Для виконання практичної частини лабораторних робіт будемо використовувати 

програму Sentaurus TCAD фірми Synopsys. Інструкція по запуску Sentaurus TCAD 

наведена в [20]. Sentaurus TCAD призначений для моделювання технологічних операцій 

(технологічного процесу) виготовлення інтегральних мікросхем, мікро- та 

наноелектронних структур, а також моделювання електрофізичних характеристик 
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створених пристроїв. Перевагою використання Sentaurus TCAD є можливість створення 

мікро- та наноелектронних структур (діодів, транзисторів. тиристорів, світлодіодів, 

лазерних діодів, оптичних сенсорів, елементів пам'яті, тощо) шляхом високоточного 

моделювання технологічних процесів їх виготовлення та електричних характеристик 

одержаних структур. Початкове налаштування та випробовування пристрою можна 

проводити на комп'ютері, що значно спрощує та здешевлює процес розробки. Моделі 

Sentaurus TCAD можна налаштувати під обладнання конкретного заводу, що значно 

збільшує точність моделювання. Існує можливість створити вихідні файли для 

виготовлення створених мікро та наноелектронних структур на сучасних заводах. Також 

можливе створення SPICE моделей одержаних напівпровідникових пристроїв для їх 

подальшого моделювання в SPICE симуляторах електронних схем (LTSpice, Orcad, 

Cadence Virtuoso, тощо). 

Sentaurus TCAD є пакетом прикладних програм. В першій лабораторній роботі 

розглянемо такі програми, як Ligament, Sentaurus Process, Prolyt та Tecplot. 

Ligament - програма для визначення послідовності та характеристик технологічних 

операцій виготовлення мікроелектронного пристрою (вирощування оксиду кремнію, 

фотолітографія, іонна імплантація, тощо). Ligament дозволяє сформувати командний файл 

для програми моделювання технологічного процесу. 

Sentaurus Process - програма моделювання технологічних операцій виготовлення 

мікроелектронного пристрою (дифузія, іонна імплантація, епітаксія, тощо) з урахуванням 

усіх відомих фізичних ефектів та найточніших моделей фізичних процесів. Вхідні дані 

про порядок та характеристики технологічних процесів формуються або в програмі 

Ligament або у вигляді текстового командного файлу. В результаті роботи Sentaurus 

Process одержуємо структуру мікроелектронного пристрою, який буде виготовлено після 

виконання заданих технологічних операцій.  

Prolyt - редактор топології інтегральних мікросхем, який можна використовувати 

для створення фотолітографічних масок.  

Tecplot - програма для перегляду результатів моделювання (структури одержаного 

пристрою, вольт-амперних характеристик, тощо). 

 

1.2.2. Мета та завдання лабораторної роботи 

 

Метою лабораторної роботи є створення послідовності технологічних операцій 

виготовлення напівпровдникового діода та одержання його двовимірної і тривимірної 

структури в результаті моделювання заданих технологічних операцій. 
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Завданням на лабораторну роботу є виконання студентом описаних далі кроків по 

створенню технологічних операцій виготовлення напівпровідникового діода. 

 

Хід роботи 

 

1.2.3. Створення директорії та запуск терміналу 

 

Створіть директорію для виконання лабораторної роботи та запустіть в ній 

програму-термінал для відпрацювання консольних команд, обравши пункт контекстного 

меню Open in Terminal 

 

1.2.4. Створення фотошаблонів в редакторі топології Prolyt 

 

Запустіть редактор топології Prolyt виконавши з щойно відкритого терміналу 

(консолі) команду prolyt & . Натисніть ОК у віконці, що з'явиться. 
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Це вікно дозволяє задати геометричні розміри області на якій можна буде 

створювати топологію. Вистачить розмірів заданих по замовчуванню. 

Після запуску, відкриється робоче вікно програми Prolyt. 

 

З лівої сторони, на панелі Layers, перераховані шари з кресленнями топології. Поки 

наявний лише один шар INIT. Можна додавати нові шари, змінювати їх імена та кольори, 

відображати на екрані, або приховувати креслення на кожному шарі. 

Для виконання лабораторної роботи необхідно створити два топологічних креслення. 

Кожне з них виконаємо в окремому шарі. Перше креслення визначає фотошаблон (маску) 

для засвічування фоторезисту під час операції створення отворів для алюмінієвого 

контакту до області n-типу діода. Назвемо шар з цим кресленням M1. Друге креслення 

визначає фотошаблон (маску) для засвічування фоторезисту під час операції 

витравлювання залишків алюмінію при створенні алюмінієвого контакту. Назвемо шар з 

цим кресленням M2. 

Переіменуємо існуючий шар INIT на M1. Для цього двічі клацнемо лівою кнопкою 

мишки на імені цього шару. З'явиться вікно редагування властивостей шару. 
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Змінимо текст в полі Name з INIT на M1. Змінимо колір креслень в цьому шарі з 

червоного на зелений. Для збереження змін натисніть кнопку Modify. 

 

Для створення нового шару, у вікні властивостей M1 змініть ім'я з M1 на M2. Змініть 

колір з зеленого на синій та натисніть кнопку New. Буде створено новий шар з заданими 

властивостями. 
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Креслення маски M1 являє собою квадрат, який захищатиме фоторезист під ним від 

засвічування. Для створення квадрату в шарі M1, необхідно обрати цей шар, клацнувши на 

ньому у вікні Layers. Далі необхідно натиснути на кнопку “Add a new rectangle to the layer” 

 

 

Після цього за допомогою мишки намалюйте на робочій площині квадрат довільного 

розміру. 

 

Створений квадрат окреслює область фотошаблону, яка не пропускає світло. 

Для переміщення квадрату необхідно повернутися в режим вибору об’єктів 

натиснувши  та один раз клацнути по квадрату лівою кнопкою миші. Навколо 
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квадрату з’явиться червона рамка і його можна буде перетягувати по робочому простору 

за допомогою миші. 

Для редагування розмірів потрібно двічі клацнути лівою кнопкою миші в області 

створеного квадрату. По краям об’єкту з’являться маленькі червоні маркери. Якщо двічі 

клацнути на такому маркері, відкриється діалогове вікно для визначення координат 

вершини. 

Необхідно сказати кілька слів про систему координат площини в якій виконуються 

креслення топології. Координата Х розміщена по горизонталі і її значення змінюються з 

ліва на право (нуль - в лівому верхньому куті). Координата Y розміщена по вертикалі і 

змінюється з низу до верху (нуль - в лівому нижньому куті). Координати поточного 

розміщення курсору миші показані в правій нижній частині вікна Prolyt. Всі розміри у 

мікрометрах. 

 

Отже у шарі M1 необхідно створити маску у вигляді квадрату з координатами 

вершин (1,1) - ліва нижня, (1,3) - ліва верхня, (3,1) - права нижня, (3,3) - права верхня.  

Після цього необхідно створити у шарі М2 маску у вигляді квадрату з координатами 

вершин (0.5,0.5) - ліва нижня, (0.5, 3.5) - ліва верхня, (3.5, 0.5) - права нижня, (3.5, 3.5) - 

права верхня. 
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Щоб приховати відображення креслення певного шару, потрібно клацнути правою 

клавішею миші на імені цього шару у полі layers. Щоб відобразити приховане креслення 

для певного шару, необхідно клацнути правою кнопкою на імені шару ще раз. 

На малюнку нижче відображені креслення фотошаблонів для шарів М1 та М2. 

 

Залишилося обрати область для якої буде виконуватись моделювання структури та 

електрофізичних характеристик. 

Для вибору області моделювання перейдіть у відповідний режим роботи програми 

Prolyt, змінивши перемикач на панелі Mode з положення Layout в положення TCAD. Як 

бачите, наповнення вікна програми Prolyt дещо змінилося. Зверніть увагу, що панель Sim 

Regions, в якій відображаються області моделювання, поки що пуста. 
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Створені маски характеризують погляд на кремнієву пластину зверху. Нас же 

цікавлять процеси, що відбуваються всередині пластини. Область всередині пластини, для 

якої буде відбуватися моделювання, можна визначити за допомогою кнопок . 

Кнопка  задає режим 1D Simulation. В цьому режимі ви обираєте точку на 

поверхні кремнієвої пластини і моделювання фізичних процесів відбувається вздовж осі, 

що перетинає кремнієву пластину в обраній точці перпендикулярно до її поверхні. Це дає 

можливість одержати залежність певних фізичних величин та характеристик 

(напруженості електричного поля, густини об’ємного заряду, тощо) від глибини (по осі Z). 

Прикладом може бути залежність концентрацій атомів миш'яку та бору (введених 

внаслідок виконання певних технологічних операцій) від глибини кремнієвої пластини в 

обраній точці на її поверхні. 
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Кнопка  задає режим 2D Simulation. В цьому режимі ви визначаєте лінію на 

поверхні кремнієвої пластини і моделювання відбувається в двовимірній області перерізу 

кремнієвої пластини площиною, що проходить через обрану лінію перпендикулярно до 

поверхні кремнієвої пластини. Такий режим дозволяє одержати залежність певних 

фізичних величин та характеристик (напруженості електричного поля, густини об’ємного 

заряду, тощо) від координати по одній із сторін кремнієвої пластини (вісь X, або Y) та від 

глибини (вісь Z). Прикладом може бути залежність концентрації атомів домішок миш’яку 

(введених в кремнієву пластину шляхом іонної імплантації) від глибини пластини та 

координати Х (перетин в площині ХZ). 

 

Кнопка  дозволяє задати режим 3D Simulation. В цьому режимі ви визначаєте 

прямокутник на поверхні кремнієвої пластини і моделювання відбувається в трьох вимірах 

(по XY всередині обраної зони на поверхні та по глибині). Такий режим дозволяє 
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одержати значення певних фізичних величин та характеристик (напруженості 

електричного поля, густини об’ємного заряду, тощо) в будь якій точці обраної області 

всередині кремнієвої пластини. Прикладом може бути залежність концентрації атомів 

домішок в трьохвимірній структурі польового МДН транзистора. 

 

В першій частині лабораторної роботи ми будемо проводити двовимірне 

моделювання. Тож натискаємо кнопку  для визначення режиму 2D Simulation. Тепер 

необхідно створити пряму лінію вздовж якої буде проходити переріз кремнієвої пластини. 

Оскільки проектований діод симетричний, достатньо промоделювати лише половину його 

структури, оскільки інша половина буде мати такі ж характеристики. Таким чином ми 

зменшимо тривалість моделювання без зниження точності. 

Намалюйте лінію для визначення області моделювання типу 2D Simulation, як це 

показано на рисунку нижче. Властивості такої лінії (ім'я, колір) можна задати аналогічно 

до властивостей об’єктів топології. Координати кінців лінії можна визначити так само, як і 

координати вершин квадратів створених фотолітографічних масок. По замовчуванню 

створена область 2D моделювання називається SIM2D та відображається в панелі SIM 

Regions.  
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Збережіть створені фотолітографічні маски та область моделювання в файл diode.lyt, 

обравши File -> Save Layout As -> DF-ISE. Закрийте Prolyt.  

 

Майте на увазі, що при використанні формату DF-ISE кольори шарів не 

зберігаються. В нашому випадку це не критично. Для збереження кольорів шарів 

необхідно використовувати формат GDS або CIF.  

 

 

 

1.2.5. Початок роботи в Ligament 
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Запустіть програму Ligament, виконавши в терміналі (консолі) команду ligedit & . 

При цьому консоль повинна бути відкрита з каталогу лабораторної роботи. Відкриється 

вікно Ligament. 

 

На вкладці Flow відображається послідовність етапів технологічного процесу 

виготовлення мікроелектронного пристрою. Доступні етапи технологічного процесу та 

команди керування знаходяться на панелі в правому нижньому куті вікна програми. Етапи 

технологічного процесу можна перетягувати з даної панелі у вікно Flow за допомогою 

миші. 

 

На панелі Arguments відображаються параметри (налаштування, аргументи) 

обраного етапу технологічного процесу.  

 Спершу необхідно додати заголовок технологічного процесу, в якому описуються 

основні налаштування моделювання та параметри кремнієвої пластини. Для виконання 

цього кроку оберіть пункт головного меню Edit -> Add Process Header, або натисніть    

Ctrl + H. В результаті, у вікні Flow з'явиться кілька так званих макросів. Клацніть лівою 
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кнопкою миші на макросі environment і на панелі Arguments з'являться налаштування 

(аргументи) цього макросу. 

 

Щоб змінити значення певного параметру (аргументу) макросу треба двічі клацнути 

лівою кнопкою миші по імені аргументу (Name). Відриється вікно для редагування 

значень аргументу. 

 

Задайте значення аргументу Title. Для цього в полі Value редактору значень 

аргументу вкажіть текст Diode та натисніть кнопку Ок. Натискання кнопки Open Text 

Area приведе до відкривання текстового редактору для введення значного об'єму тексту. 

Перевірте, щоб значенням аргументу simulator був sprocess (програма, що 

виконуватиме моделювання етапів технологічного процесу). 
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Задайте значенням аргументу output текст @diode@. Це приведе до маркування всіх 

вихідних файлів моделювання відповідним текстом. 

 

Перевірте, щоб для аргументу graphics було виставлено значення false. Це необхідно 

для заборони появи всіх можливих графіків результатів під час симуляції. Набагато 

зручніше самому побудувати потрібний графік після закінчення симуляції. 

Перейдіть до налаштувань макросу Substrate клацнувши по ньому в полі Flow. 

Substrate дозволяє задати параметри напівпровідникової пластини на якій виготовляється 

мікроелектронний пристрій. Зверніть увагу, що значенням аргументу Material по 

замовчуванню є Silicon, тобто кремній. Однак доступно багато інших матеріалів. 
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Проставте значенням аргументу dopant матеріал Бор (boron). Цей аргумент задає 

хімічний елемент, яким буде легована напівпровідникова пластина. Окрім Бору доступно 

багато інших хімічних елементів. В даному випадку розподілення хімічних елементів в 

кремнієвій пластині буде рівномірне. Тобто в кожному кубічному сантиметрі буде 

знаходитись постійна концентрація атомів обраного хімічного елементу. Концентрація 

домішок обраного хімічного елементу в кремнієвій пластині задається аргументом 

concentration. Виставимо його значення рівним 1e16 з одиницями вимірювання /cm3. Це 

означає, що в одному кубічному сантиметрі кремнієвої напівпровідникової пластини буде 

знаходитись 1016 атомів Бору. Оскільки у якості домішок використовуємо Бор, кремнієва 

пластина буде мати провідність p-типу. Макросом resistivity можна задати питомий опір 

кремнієвої пластини, а макросом orientation її кристалографічну орієнтацію в індексах 

Міллера. По замовчування виставлена орієнтація 100. 
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Загалом, аргументи макросу Substrate виглядатимуть таким чином: 

 

Тепер необхідно підключити до створюваного технологічного процесу 

фотолітографічні маски, раніше розроблені в prolyt. Для цього оберіть пункт головного 

меню File -> Open Layout та відкрийте раніше збережений файл з топологією. При 
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відкриванні збереженого технологічного процесу цю операцію необхідно виконувати 

кожного разу. 

 

Після підключення файлів з топологією мікроелектронного пристрою необхідно 

вказати область, в якій буде виконуватись симуляція (моделювання). Ми цю область 

визначили раніше в редакторі Prolyt та зберегли інформацію про неї в файлі diode.lyt, який 

щойно відкрили в Ligament. Знову переходимо до налаштувань аргументів макросу 

environment. Обираємо аргумент region та виставляємо його значення в SIM2D. 

 

Зверніть увагу, що цю операцію необхідно виконувати після підключення файлу з 

інформацією про топологію та визначену область симуляції. 

Натисніть на кнопку Translate the current flow . В результаті, з послідовності 

етапів технологічного процесу (макросів) на панелі Flow буде створено командний файл 

для симулятора технологічного процесу. 
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Якщо натиснути на кнопку Check simulator syntax , буде виконана перевірка 

правильності створеного командного файлу. Одержавши інформацію про успішне 

завершення перевірки, можна зберегти створений командний файл обравши пункт 

головного меню File -> Save Translated Flow As. Іменем командного файлу нехай буде 

diode_fps.cmd 
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Щойно ми створили командний файл для моделювання послідовності технологічних 

операцій (макросів), наявних на панелі Flow. Поки що послідовність ця невелика і містить 

лише заголовок технологічного процесу, що складається з макросів environment та 

substrate, які визначають параметри моделювання і кремнієвої пластини. Для повернення в 

режим редагування технологічного процесу натисніть копку Back To Edit Mode . 

Збережемо даний технологічний процес в файл diode_lig.cmd, обравши пункт головного 

меню File -> Save As. 

 

 Зверніть увагу, що ми щойно зберегли проект Ligament, а перед цим зберігали 

командний файл для симулятора технологічного процесу. Командний файл diode_lig.cmd 

можна пізніше відкрити в Ligament і продовжити редагування технологічного процесу, 

після чого створити новий командний файл для симулятора і знову зберегти його. 

Поки що закриємо програму Ligament і виконаємо моделювання найпростішого 

командного файлу технологічного процесу, який ми щойно створили в Ligament. 

Для цього відкрийте консоль (термінал) з каталогу лабораторної роботи та виконайте 

в терміналі команду sprocess diode_fps.cmd. Очевидно, що цією командою ми запускаємо 

на виконання програму для моделювання технологічного процесу Sentaurus Process 

(sprocess) і передаємо їй у якості аргументу командний файл diode_fps.cmd. У випадку 

успішного завершення моделювання, на консоль будуть виведені наступні повідомлення. 
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Для перегляду результатів симуляції запустимо програму Tecplot, виконавши з 

терміналу (консолі) команду tecplot_sv  -mesa & . З'явиться вікно програми Tecplot. 

 

Після завершення моделювання, програма sprocess створює файли diode_bdn.tdr та 

diode_fps.tdr. Файл diode_bdn.tdr містить інформацію про структуру і геометричні 

розміри напівпровідникового приладу, який було створено внаслідок моделювання 

технологічного процесу. Файл diode_fps.tdr на додачу містить інформацію про 

концентрації атомів матеріалів та механічні напруження в будь-якій точці 

мікроелектронної структури. 

Необхідно відкрити ці файли для перегляду в Tecplot. Для цього оберіть пункт 

головного меню File -> Load. З'явиться вікно вибору файлів. 
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Виділіть файли diode_bdn.tdr та diode_fps.tdr, а потім натисніть кнопки Add і OK. 

 

Відкриється вікно з зображенням створеної кремнієвої пластини. Поки що там нічого 

цікавого немає, оскільки ми не виконували жодних технологічних операцій. 

Якщо після масштабування зображення зникне, необхідно натиснути кнопку 

перемальовування вмісту вікна . 
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Закриємо Tecplot і повернемося до створення технологічного процесу. Для цього 

необхідно знову запустити Ligament. Не забудьте після відкриття збереженого проекту в 

Ligament відкрити файл з топологією, інакше виникатимуть помилки. 

 

1.2.6. Створення шару SiO2 з домішками фосфору на поверхні кремнієвої пластини 

 

Першим етапом технологічного процесу стане нанесення на поверхню кремнієвої 

пластини шару оксиду кремнію з домішками фосфору (так зване Spin-on glass). Цей шар 

буде використовуватись, як джерело донорних атомів під час наступної операції дифузії.  

Дана технологічна операція детальніше описана у розділі 1.1.11 методичних 

вказівок, а також у джерелах [22-23].  

Для моделювання операції нанесення spin-on glass перетягніть макрос deposit з 

правої нижньої частини вікна в список технологічних операцій в панелі Flow, на позицію, 

що знаходиться одразу після закінчення заголовку технологічного процесу. 

 

Макрос deposit дозволяє наносити на поверхню заготовки шар певного матеріалу 

заданої товщини. Клацніть лівою кнопкою миші на макросі deposit на панелі Flow і у 

сусідньому вікні Arguments з'являться параметри (аргументи) цього етапу технологічного 

процесу. Спершу необхідно обрати матеріал. В нашому випадку це буде оксид кремнію. 

Отже значенням аргументу material необхідно обрати Oxide. Ознайомтеся з іншими 

28 



матеріалами, які можна наносити на поверхню заготовки (в нашому випадку кремнієвої 

пластини). 

 

Виставте аргумент thickness (товщину шару) в 3000 Ангстрем, матеріал домішок 

(dopant) - фосфор (Phosphorus), концентрація домішок (concentration) 5e21 (5*1021) на 

см3.  

В результаті виконання даного етапу технологічного процесу, на поверхні кремнієвої 

пластини буде створено шар оксиду кремнію SiO2 товщиною 3000 Ангстрем, в якому 

будуть рівномірно розподілені атоми домішок фосфору з концентрацією 5*1021 на см3. 

Вікно Arguments технологічної операції deposit повинно виглядати таким чином. 
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Знову збережіть технологічний процес в Ligament, створіть командний файл для 

симулятора, збережіть його в diode_fps.cmd, виконайте моделювання (sprocess 

diode_fps.cmd) та відкрийте результати моделювання в Tecplot. 

 

Видно, що зараз над поверхнею кремнієвої платини з'явився шар матеріалу, який був 

нанесений в заданому технологічному процесі. 

Давайте детальніше ознайомимось з інтерфейсом програми Tecplot. По-перше, 

необхідно розібратися з координатними осями Х та Y. Це не ті XY координати, що були в 

редакторі Prolyt. В Tecplot для випадку двовимірного моделювання (як у нас зараз) 
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координата Y характеризує глибину кремнієвої пластини, а координата X - ту сторону 

пластини, по якій проходив розріз при визначенні області моделювання. 

Зверніть увагу на наступні елементи інтерфейсу: 

 

В верхньому списку можна обирати області структури до яких будуть застосовані 

кнопки з нижньої панелі. Кнопка  вмикає відображення сітки для методу скінченних 

елементів. Кнопка  вимикає відображення такої сітки. TCAD вирішує диференційні 

рівняння фізичних процесів, що відбуваються при проведенні технологічних операцій, за 

допомогою чисельного методу скінченних елементів. Для реалізації такого методу 

необхідно створити спеціальну координатну сітку. В даному випадку вона створюється 

автоматично, але пізніше ми розглянемо як створити її вручну. 

 

 

1.2.7. Виконання операції дифузії 

 

Щоб донорні атоми фосфору дифундували з тонкого шару Spin-On glass в кремнієву 

пластину p-типу, необхідно її нагріти на певний час до певної температури. Внаслідок 
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такої операції концентрація донорів в приповерхневому шарі кремнієвої пластини значно 

перевищить концентрацію акцепторів, що приведе до зміни типу провідності з p на n.  

Нагрівання можна реалізувати за допомогою макросу anneal. Необхідно перетягнути 

цей макрос з правої нижньої частини вікна Ligament на позицію після макросу deposit. 

 

Виставте тривалість нагрівання 60 хвилин і температуру 900 градусів по Цельсію. 

Можна обрати тип, швидкість протоку та тиск газу (або газів) в камері під час операції 

нагрівання. В нашому випадку не обрано жодного з газів, тому нагрівання буде 

відбуватися у вакуумі і аргумент pressure ігноруватиметься.  

Збережіть оновлену версію технологічного процесу в Ligament, створіть для неї 

командний файл симулятора та збережіть його в diode_fps.cmd. Виконайте симуляцію 

технологічного процесу в sprocess та відкрийте результати моделювання в Tecplot. Як 

бачите, у вікні Tecplot з'явилося багато нової інформації. По-перше, з'явилася можливість 

переглянути концентрації атомів домішок (фосфору і бору) та дефектів кристалічної 

гратки (вакансій та міжвузлів) в будь-якій точці напівровідникової пластини. Чому ця 

інформація з'явилася лише зараз? TCAD оновлює дану інформацію саме після виклику 

команди diffuse, яка входить до складу використаного макросу anneal. Подивіться на 

уривок щойно створеного командного файлу з командою diffuse: 

 

Якщо ви хочете оновити інформацію про зазначені концентрації, потрібно вставити 

в необхідну позицію командного файлу команду diffuse з нульовою тривалістю.  
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З переліку на панелі в лівій стороні Tecplot можна обрати концентрацію, що нас 

цікавить і вона відобразиться у вигляді кольорової мапи (кожному кольорі на екрані 

відповідає певна концентрація). 

 

В даному переліку представлені наступні фізичні величини (одиниці вимірювання 

концентрацій см-3): 

- BoronActiveConcentration(BActive) - концентрація атомів Бору в кремнієвій 

пластині, які не утворюють дефектів кристалічної гратки (всі ці атоми Бору 

знаходяться в кристалічній гратці на своїх місцях); 

- BoronConcentration(BTotal) - концентрація всіх атомів Бору в кремнієвій 

пластині, враховуючі ті атоми, що утворюють дефекти кристалічної гратки 

(вакансії, чи міжвузля); 

- DopingConcentration(NetActive) - різниця концентрацій атомів донорів та 

акцепторів. В нашому випадку NetActive = PActive - BActive. Якщо NetActive > 0 

напівпровідник має провідність n-типу, якщо NetActive < 0 напівпровідник має 

провідність p-типу. У власного напівпровідника значення NetActive близьке до 0; 
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- InterstitialConcentration(ITotal) - концентрація дефектів кристалічної гратки 

(міжвузлів); 

- PhosphorusActiveConcentration(PActive) - концентрація атомів Фосфору в 

кремнієвій пластині, які не утворюють дефектів кристалічної гратки (всі ці атоми 

знаходяться в кристалічній гратці на своїх місцях); 

- PhosphorusConcentration(PTotal) - концентрація всіх атомів Фосфору в кремнієвій 

пластині, враховуючі ті атоми, що утворюють дефекти кристалічної гратки 

(вакансії, чи міжвузля); 

- Stress-XX...Stress-ZZ - механічні напруження, що виникають в кристалі (одиниця 

вимірювання - Паскаль); 

- VacancyConcentration(VTotal) - концентрація дефектів кристалічної гратки 

(вакансій). 

Обравши будь-яку з перелічених концентрацій, можна подивитись її просторовий 

розподіл у вигляді кольорової мапи, де певному кольору відповідає певна концентрація. 

На малюнку нижче зображений кольоровий розподіл концентрації NetActive: 

 

Переглянути значення необхідної концентрації в будь-якому місці кремнієвої 

пластини можна за допомогою інструменту Probe. Для цього натисніть кнопку  та 

клацніть в будь-якому місці на зображення розрізу кремнієвої пластини. З'явиться вікно з 

параметрами пластини у вибраній точці. 
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Це не всі результати. Натиснувши на кнопку  можна перейти до невидимої 

частини списку змінних. Для повернення до індикації змінних V1-V10 натисніть на 

кнопку . Зверніть увагу, що в одержаному списку присутні всі раніше розглянуті 

параметри саме для обраної точки в структурі кремнієвої пластини. 

Дослідіть значення концентрацій в різних точках кремнієвої пластини. 

Переконайтесь, що зі збільшенням глибини концентрація донорних атомів фосфору 

знижується. В той же час концентрація акцепторних атомів бору майже однакова по 

всьому об'єму кремнієвої пластини (1016) та дещо зменшується біля границі з оксидом 

кремнію з домішками фосфору. Дослідіть концентрації атомів домішок в заданому шарі 

оксиду кремнію. Чим обумовлені такі зміни концентрацій? 
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Зверніть увагу на коричневу лінію, що розділяє області напівпровідників n-типу та p-

типу. Це p-n перехід. Переконайтесь, що в області  p-n переходу концентрації донорних і 

акцепторних атомів майже рівні. 

 

Чудовим інструментом TCAD є можливість будувати графіки залежності фізичної 

величини від однієї з координат при фіксованих інших координатах. Для цього спершу 

необхідно обрати фізичну величину. Нехай це буде концентрація атомів фосфору 

PhosphorusActiveConcentration. Далі потрібно натиснути на кнопку  (розріз по X) і 

клацнути по двовимірному рисунку кремнієвої пластини в тій координаті X, яку 

необхідно зафіксувати. Tecplot побудує залежність концентрації атомів фосфору від 

глибини (Y) при заданій координаті X. Можна аналогічно побудувати залежність фізичної 

величини від X при фіксованому Y, натиснувши кнопку . У випадку тривимірного 

моделювання можна робити і розріз по Z за допомогою . 
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Щоб точно задати координати розрізу, оберіть пункт головного меню Slicer -> 

Orthogonal Cut. Відкриється відповідне вікно.  

 

Спершу знімаєте галочку .Далі обираєте вісь розрізу (X, Y, або 

Z) і вводите координату місця розрізу на обраній осі. Натискаєте  і одержуєте 

графік необхідного розрізу. Також можна створити кілька розрізів в певному діапазоні 

значень координати обраної осі. 

Для масштабування графіку необхідно натиснути кнопку . Після цього клацаєте 

мишкою в області, яку необхідно наблизити. Для віддалення графіку необхідно клацати на 
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ньому мишкою при натиснутій клавіші Ctrl. Щоб вміст графіку зайняв всю видиму 

область, необхідно натиснути кнопку . 

Комбінації клавіш для керування програмою Tecplot можна переглянути обравши 

пункт головного меню Help -> Keyboard Shortcuts. 

 

1.2.8. Виконання фотолітографії для створення отвору під металічний контакт до 

верхньої області діода (n-типу)  

 

Операція фотолітографії (створення отворів у фоторезисті) реалізується в Ligament за 

допомогою макросу pattern. Перетягніть макрос pattern з правої нижньої частини вікна 

Ligament на панель Flow в позицію після макросу anneal. Для аргументу layer оберіть 

маску M1. Тип фоторезисту задається аргументом polarity. Необхідний негативний 

фоторезист, тож ставимо polarity в значення dark field. Товщину фоторезисту задає 

аргумент thickness. Виставляємо його в 1 мкм. 

Щойно визначений макрос виконує нарощування негативного фоторезисту 

товщиною 1 мкм на поверхні кремнієвої пластини, його засвічування через 

фотолітографічну маску M1 і проявлення. Оскільки фоторезист негативний, а маска являє 

собою світлонепроникний квадрат, засвічені області фоторезисту затвердіють, а 

незавічена область, яку накриває квадрат, змиється під час проявлення. Одержимо отвір у 

фоторезисті на місці квадрату фотолітографічної маски М1. 
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Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Тепер фоторезист захищає частину оксиду на поверхні кремнієвої 

пластини. 

 

 

 

 

1.2.9. Зтравлювання оксиду кремнію через отвори у фоторезисті 

 

В Ligament операція травлення виконується макросом etch. Перетягніть цей макрос в 

останню позицію на панелі Flow. Аргумент material визначає матеріал, травлення якого 

відбуватиметься. Виставте material в значення Oxide (оксид кремнію). Тип травлення 

(аргумент etch_type) виставте в anisotropic (анізотропне травлення без підтравлювання 

під маску). 

Ось так повинен виглядати технологічний процес на панелі Flow та значення 

аргументів макросу etch.  
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Товщина матеріалу видаленого шляхом зтравлювання (глибина травлення) 

визначається аргументами thickness або etchstop. Якщо не використовувати жоден з цих 

аргументів (залишити значення по замовчуванню), травлення відбуватиметься доки не 

буде видалено весь матеріал заданий аргументом material. Аргумент thickness визначає 

глибину травлення у вигляді числового значення (в мікрометрах, нанометрах, або 

ангстремах). Ця величина повинна бути менша товщини матеріалу, заданого аргументом 

material. В іншому випадку, буде видалено весь шар матеріалу. Аргумент overetch вказує 

додаткову глибину травлення і задається у відсотках значення аргументу thickness. 

Наприклад, якщо thickness = 1 мкм, а overetch = 20%, буде зтравлено 1.2 мкм. Однак, якщо 

в такому випадку товщина матеріалу всього 1 мкм, буде зтравлено лише 1мкм, оскільки 

видаляється лише матеріал заданий аргументом material.  

Оскільки в нашому випадку необхідно зняти весь шар оксиду кремнію з домішками 

фосфору, товщину травлення можна не вказувати, а можна вказати реальну товщину шару 

- 0.3 мкм. В документації на TCAD рекомендують завжди виставляти overetch рівним 1-

10% для гарантованого зняття необхідної товщини матеріалу (щоб не виникало випадків 

недотравлювання внаслідок незначних похибок обчислень). 

Аргументом etchstop можна задати матеріал, при досягненні якого процес травлення 

буде зупинено. 

Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що шар оксиду кремнію, не захищений 

фоторезистом, було видалено без підтравлювання під фоторезист. 
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1.2.10. Видалення фоторезисту 

 

Видаляти фоторезист з поверхні кремнієвої пластини будемо за допомогою макросу 

etch. Встановіть аргумент material в значення photoresist. Аргумент etch_type виставте в 

значення strip, що відповідає повному видаленню матеріалу з поверхні.  

 

Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що весь фоторезист з поверхні було видалено. 

 

 

1.2.10. Нанесення шару алюмінію 
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Для нанесення шару алюмінію на поверхню розроблюваної структури скористаємось 

уже знайомим макросом deposit. Аргументом material даного макросу виставте aluminum. 

За допомогою аргументу thickness задайте товщину шару алюмінію - 2500 ангстрем. 

 

Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що тепер вся поверхня покрита шаром алюмінію 

товщиною 2500 ангстрем. 

 

 

 

1.2.11. Виконання фотолітографії для видалення частини алюмінію  

 

Для виконання цієї фотолітографії знову застосуємо макрос pattern. За допомогою 

аргументу layer задамо маску M2 для проведення фотолітографії. Цього разу будемо 

використовувати позитивний фоторезист, тож встановіть значення аргументу polarity в 

light_field. Товщину шару фоторезисту задамо рівною 1 мкм за допомогою аргументу 

thickness. 
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Не закритий маскою фоторезист буде засвічений і видалений під час проявки. 

Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що в засвіченій області фоторезист відсутній. 

 

 

 

1.2.12. Видалення областей алюмінію не закритих фоторезистом 

 

Для видалення областей алюмінію не закритих фоторезистом застосуємо уже 

відомий макрос etch. Аргумент material виставте в значення aluminum. Для уникнення 

підтравлювання під маску значення аргументу etch_type встановіть в anisotropic. Аргумент 

overetch нехай буде 10%. 
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Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що не закритий фоторезистом алюміній видалено. 

 

 

 

1.2.13. Видалення фоторезисту 

 

Видаліть фоторезист з використанням макросу etch, як це ви вже робили в п.8 

лабораторної роботи. Технологічний процес виглядатиме так: 
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Збережіть щойно удосконалений технологічний процес в Ligament, створіть 

командний файл та виконайте його моделювання в sprocess. Перегляньте результати 

моделювання в Tecplot. Переконайтесь, що структура напівпровідникового діода, 

виготовлена в результаті моделювання створеного технологічного процесу, виглядає 

наступним чином: 

 

 

1.2.14. Моделювання технологічного процесу в 3D 

 

Відкрийте раніше створений і збережений файл diode.lyt. Додайте до нього область 

3D моделювання SIM3D. Збережіть файл під іменем diode3D.lyt  

 

Відкрийте в програмі Ligament технологічний процес створений в п.12 лабораторної 

роботи. За допомогою пункту головного меню File -> Open Layout підключіть файл 

diode3D.lyt. Аргумент region макросу environment виставте в значення SIM3D. Створіть 

командний файл для sprocess та збережіть його під іменем diode3D_fps.cmd. Відкрийте 

цей файл в текстовому редакторі. Видаліть строку “eval exec prolyt -batch -convertto dfise 
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n1_prl.par”. В строці “mask layoutfile=n1_prl.par” замініть n1_prl.par на diode3D.lyt. 

Збережіть зміни в файлі. Промоделюйте створений технологічний процес в трьох вимірах, 

виконавши з консолі команду sprocess  diode3D_fps.cmd.  

Відкрийте результат моделювання в програмі Tecplot. За допомогою кнопки  

можете обертати структуру в трьох вимірах. За допомогою кнопок  спробуйте 

робити розрізи по X, Y, Z. Для масштабування розрізу клацніть на його графік та 

натисніть кнопку . 
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ПІДСУМОК 

 

В даній лабораторній роботі ви навчилися розробляти і моделювати технологічні 

процеси створення двовимірних та трьохвимірних мікроелектронних структур в Sentaurus 

TCAD. В наступній лабораторній роботі ви здобудете навички моделювання електричних 

характеристик одержаних мікроелектронних структур на прикладі одержання прямої та 

зворотної гілок вольт-амперної характеристики щойно створеного діода. 
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КОНТРОЛЬНІ ЗАПИТАННЯ 

  

Запитання по технологічним процесам 

  

1.      Чим відрізняється технічний кремній від полікристалічного та монокристалічного? 

2.      Які відмінності між моно кристалічним кремнієм електронної та сонячної якості? 

3.      Поясніть процедуру виготовлення монокристалічного кремнію за методом 

Чохральського; 

4.      Поясніть метод індукційної плавки металів та напівпровідників; 

5.    Як відбувається розрізання злитку монокристалічного кремнію на пластини? Який діаметр 

та товщина таких пластин? 

6.    Навіщо поверхню пластин очищають перед технологічними операціями? Які бувають типи 

забруднення поверхні пластин? Як видаляють ці забруднення? 

7.      Для яких цілей використовують шар оксиду кремнію? 

8.  Як відбувається вирощування шару оксиду кремнію? Чим відрізняється окислення кремнію 

в атмосфері сухого кисню та у парах води? 

9.      Від чого залежить швидкість росту шару оксиду кремнію? 

10.  Яку товщину шару оксиду кремнію зазвичай використовують? 

11. Для яких цілей використовують полікристалічний кремній легований домішками для 

збільшення провідності? 

12.  Поясніть технологічний процес епітаксії. Для яких цілей використовують епітаксію? 

13.  Що таке ізотропне травлення в рідких кислотах та який недолік воно має? 

14.  Як швидкість травлення кремнію залежить від його кристалографічної орієнтації? 

15.  Що таке анізотропне травлення в плазмі та для чого використовується? Який механізм 

анізотропного травлення в плазмі? 

16.  Поясніть технологію фотолітографії; 

17.  Чим позитивний фоторезист відрізняється від негативного? 

18.  Що таке фотошаблон і як його виготовляють? 

19.  Що таке сканер (степпер)? 

20.  Як видаляють фоторезист? 

21.  Поясніть метод введення домішок в напівпровідник шляхом дифузії; 

22.  Поясніть перший та другий закони Фіка; 

23.  Від чого залежить швидкість протікання дифузії домішок? 

24.  Чим відрізняється дифузія із обмеженого та необмеженого джерела? 
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25.  Намалюйте графіки розподілення домішок в напівпровіднику після дифузії з обмеженого 

та необмеженого джерела; 

26.   Поясніть метод введення домішок в напівпровідник шляхом іонної імплантації; 

27.  Навіщо після іонної імплантації проводять процедуру відпалу? 

28. Від чого залежить ступінь заглиблення домішок в напівпровідникову пластину під час 

іонної імплантації? 

29.  Намалюйте графіки розподілення домішок в напівпровіднику після іонної імплантації; 

30. Поясніть метод ізоляції напівпровідникових пристроїв (діодів, транзисторів) за допомогою 

зворотнозміщеного pn-переходу; 

31.  Поясніть пленарно-дифузійну технологію виготовлення напівпровідникового діода; 

  

Запитання по практичній роботі в програмі Sentaurus TCAD 

  

32.  Поясніть макроси (та їх аргументи), що були використані при створенні технологічного 

процесу виготовлення напівпровідникового діода в Ligament; 

33.  Поясніть процес створення масок в Prolyt та їх підключення до Ligament; 

34.  Що таке simulation region та навіщо його визначати в Prolyt? 

35.  Як в Ligament створити командний файл для симулятора Sprocess? 

36.  Поясніть структуру напівпровідникового діода, одержану внаслідок результату симуляції 

Sprocess та відображену в програмі Tecplot. 

 

 

 

 

 

 

 

 

 

 

  

 


